DRTECH EVS 3643 System
Safety and Regulatory Information
with User’s Manual
Thank you for purchasing the DRTECH Radiography EVS 3643 (hereinafter this Product). This User’s Manual explains how to use the detector, x-ray interface unit, and other peripheral equipment. Before using this product, be sure to read this manual thoroughly in order to utilize it more effectively. Also, read the Operation Manual for EVS Calibration and configuration Software (hereinafter ECali1).

**Important information on usage and management of equipment**

1. Only a physician or legally certified operator should use this product.
2. The equipment should be maintained in a safe and operable condition by maintenance personal.
3. Use only computers and image display monitors complying with IEC 60601-1 or IEC 60950-1 and under system configuration complying with IEC 60601-1-1. For details, consult your sales representative or local DRTECH dealer.
4. Use only the dedicated cables. Do not use any cables other than those supplied with this product.

**Disclaimer**

1. In no event shall DRTECH be liable for any damage or loss arising from fire, earthquake, any action or accident by a third party, any intentional negligent action by users, any trial usage, or other usage under abnormal conditions.
2. Roentgenography, image processing, image reading, and image data storage must be performed in accordance with the laws of the country or region in which the product is being used. The user is responsible for manufacturing the privacy of image data.
3. In no event shall DRTECH be liable for personal physical harm or property damage that is sustained when the instructions are not followed or the product is misused.
4. It is the responsibility of the attending physicians to provide medical care services. DRTECH will not be liable for faulty diagnoses.
5. In no event shall DRTECH be liable for direct or indirect consequential damages arising from the use or unavailability of this product. DRTECH shall not be liable for loss of image data for any reason.
6. In no event shall DRTECH be liable for any damage arising from moving, alteration, inspection or repair by a person other than authorized service engineers.
7. Specifications, composition, and appearance of this product may change without prior notice.
## Contents

1. **To Customers** .................................................. 2

2. **Contents** .................................................. 3

3. **Conventions** .................................................. 5

4. **1. Safety information** ........................................... 6
   1-1. Safety precautions ............................................. 6
   1-2. Notes for using the equipment ................................ 10

5. **2. Introduction** .................................................. 12
   2-1. Features .......................................................... 12
   2-2. Intended use ..................................................... 12
   2-3. System configuration .......................................... 13

6. **3. Product description** .......................................... 14
   3-1. Product components ............................................ 15
   3-2. X-ray imaging condition .................................... 16

7. **4. Parts name and functions** .................................. 17
   4-1. Detector specification ........................................ 17
   4-2. Detector component ........................................... 18
   4-3. Detector dimension ............................................ 19
   4-4. SSU (System synchronization unit) .......................... 20
   4-5. Wireless access point ........................................ 20

8. **5. Operating procedure** ....................................... 22
   5-1. Preparing to use the detector ............................. 23
   5-2. Operating the detector ....................................... 23
   5-3. Ending use of the detector ................................. 27
   5-4. Detector status list ........................................... 27
5. Operating procedure

6. Extension facility

6-1. Using the wriless detector with other EXPRIMER series detectors in a same system ...
6-2. Sharing the wireless detector among different systems
6-3. AED mode
6-4. Wiring connections

6. How to Install

6. Troubleshooting

6. Maintenance

10. Specification

10-1. Main specifications
10-2. Characteristics

11. Regulatory information

11-1. Medical equipment safety standards
11-2. Radio frequency (RF) compliance information
11-3. Labels and markings on the equipment
11-4. Guidance and manufacturer’s declaration for EMC

12. Warranty
Safety notices

The following safety notices are used to emphasize certain safety instructions. Follow the safety instructions in this user's manual along with warning and cautions symbols. Ignoring such warnings or cautions while handling the product may result in serious injury or accident. It is important for you to read and understand the contents of this user's manual before attempting to use the product.

**WARNING**
This notice is used to identify conditions under which improper use of the product may cause death or serious personal injury.

**CAUTION**
This notice is used to identify conditions under which improper use of the product may cause minor personal injury.

**CAUTION**
This notice is used to identify conditions under which improper use of the product may cause property damage.

This is used to indicate a prohibited operation.

This is used to indicate an action that must be performed.

This is used to indicate important operations and restrictions. Be sure to read this notice to prevent property damage or malfunction.

This is used to indicate operations for reference and complementary information. User are recommended to read this notice.
1. Safety information

1-1. Safety precautions

Follow these safeguards and properly use the equipment to prevent injury and damage to any equipment/data.

WARNING

Installation and environment of use

- **Prohibited**

  - Do not use or store the equipment near flammable chemical such as alcohol, thinner, benzine, etc.
  
  If chemicals are spilled or evaporate, it may result in fire or electric shock through contact with electric parts inside the equipment. Also, some disinfectants are flammable. Be sure to take care when using them.

- **Prohibited**

  - Do not connect the equipment with anything other than specified.
  
  Doing so may result in fire or electric shock.

Power supply

- **Prohibited**

  - Do not use operate the equipment using any type of power supply other than the one indicated on the rating label.
  
  Otherwise, it may result in fire or electric shock.

- **Prohibited**

  - Do not handle the equipment with wet hands.
  
  You may experience an electric shock that could result in death or serious injury.

  - Do not place heavy object such as medical equipment on cables and cords, or do not pull, bend, bundle, or step on them to prevent their sheath from being damaged, and do not alter them neither.
  
  Doing so may damage the cords which could result in fire or electric shock.

  - Do not supply power to more than one of equipment using the same AC outlet.
  
  Doing so may result in fire or electric shock.

  - Do not turn on the system power when condensation has formed on the equipment.
  
  Doing so may result in fire or electric shock.

  - Do not connect a multiple portable socket-outlet or extension cord to the system.
  
  Doing so may result in fire or electric shock.

- **Prohibited**

  - Securely plug the power cord into the AC outlet.
  
  If contact failure occurs, or if dust or metal objects come into contact with the exposed metal prong of the plug, fire or electric shock may result.

  - Be sure to turn OFF the power to each of equipment before connecting or disconnecting the cords.
  
  Otherwise, you may get an electric sock that could result in death or serious injury.

  - Be sure to hold the plug or connector to disconnect the cord.
  
  If you pull the cord, the core wire may be damaged, resulting in fire or electric shock.
### Handling

The system, in whole or in part, cannot be modified in any way without written approval from DRTECH.

- **Prohibited**
  - No modification of this equipment is allowed
  - Never disassemble or modify the equipment.
  
  Doing so may result in fire or electric shock. Also, since the equipment incorporates parts that may cause electric shock as well as other hazardous parts, touching them may cause death or serious injury.

- **Prohibited**
  - Do not place anything on top of the equipment.
  
  The object may fall and cause an injury. Also if metal objects such as needles or clips fall into the equipment, or if liquid is spilled, it may result in fire or electric shock.

- **Prohibited**
  - Do not hit or drop the equipment.
  
  The equipment may be damaged if it receives a strong jolt, which may result in fire or electric shock if the equipment is used without being repaired.

- **Prohibited**
  - Have the patient take a fixed posture and do not let patient touch parts unnecessarily.
  
  If the patient touched connectors or switches, it may result in electric shock or malfunction of the equipment.

### When a problem occurs

- **Prohibited**
  - Should any of the following occur, immediately turn OFF the power to each piece of equipment, unplug the power cord from the AC outlet, and contact your sales representative or local DRTECH dealer:
    - When there is smoke, an odd smell or abnormal sound
    - When liquid has been spilled into equipment or metal object has entered through an opening.
    - When the equipment has been dropped and is damaged.

### Maintenance and inspection

- **Prohibited**
  - When the equipment is going to be cleaned, be sure to turn OFF the power of each equipment, and unplug the power cord from the AC outlet. Never use alcohol, benzine, thinner or any other flammable cleaning agent.
    
    Otherwise, it may result in fire or electric shock.

- **Prohibited**
  - Clean the plug of the power cord periodically by unplugging it from the AC outlet and removing dust or dirt from the plug, its periphery and AC outlet with a dry cloth.
    
    If the cord is kept plugged in for a long time in a dusty, humid or sooty place, dust around the plug will attract moisture, and this could cause insulation failure that could result in a fire.

- **Prohibited**
  - For safety reasons, be sure to turn OFF the power to each piece of equipment when the inspections indicated in this manual are going to be performed.
    
    Otherwise, electric shocks may occur.
1. Safety information

**WARNING**

Installation and environment of use

- Do not install the equipment in any of the locations listed below. Doing so may result in failure or malfunction, equipment failing, or fire or injury.
  - Close to facilities where water is used
  - where it may be exposed to direct sunlight
  - Close to the air outlet of an air-conditioner or ventilation equipment
  - Close to a heat source such as a heater
  - where the power supply is unstable
  - In a saline or sulfurous environment
  - where temperature or humidity is high
  - where there is freezing or condensation
  - In area prone to vibration
  - On an incline or in an unstable area
- Because the equipment cable is long, take care that cables do not become tangled during use. Also, be careful not to get your feet caught in the cable. Otherwise, it may cause a malfunction of the equipment or the injury of the user due to tripping over the cable.
- Non-medical equipment such as the battery charger, and access point unit cannot be used in patient’s vicinity.

**Patient Vicinity**

Power supply

- Always connect the three-core power cord plug to a grounded AC power outlet.
- To avoid the risk of electric shock, this equipment must only be connected to a supply mains with protective earth”.
- To make it easy to disconnect the plug at any time, avoid putting any obstacles near the outlet. Otherwise, it may not be possible to disconnect the plug in an emergency.
- Be sure to ground the equipment to an indoor grounded connector. Also, be sure to connect all the grounded for the system to a common ground.
- Do not use any power source other than the one provided with this equipment. Otherwise, fire or electric shock may be caused due to leakage

Handling

- Do not spill liquid or chemicals onto the equipment or, in cases where the patient is injured, allow it to come in contact with blood or body fluids. Doing so may result in fire or electric shock. In such a situation, protect the equipment with a disposable covering as necessary.
- Turn OFF the power to each piece of equipment for safety when not being used.
1. Safety information

CAUTION

Handling the equipment

The Equipment must be handled with care to avoid personal injury or damage to the internal image sensor.

- Handle the equipment carefully.
- Do not submerge the equipment in water.
- The internal image sensor may be damaged if something hits against it, or if it is dropped, or receives a strong jolt.

![Diagram of equipment handling](image)

- Do not place excessive weight on the detector.
  Otherwise, the internal image sensor may be damaged.

<Load Limit>

Uniform load: 150 kg over the whole area of the detector

Local load: 100 kg on an area 40 mm in diameter

- Be sure to use the detector on a flat surface do it will not bend. Otherwise, the internal image sensor may be damaged. Be sure to securely hold the detector while using it in upright positions. Otherwise, the detector may fall over, resulting in injury to the user or patient, or may flip over, resulting in damage to the inner device.
1-2. Notes for using the equipment

When using the equipment, take the following precautions. Otherwise, problems may occur and the equipment may not function correctly.

**System Diagnostic**

The Ecali1 software runs a system diagnostic. Run Ecali1 software after installing the system and at least once a year. If an error occurs, report the detailed error information to DRTECH local dealer or distributor.

| CAUTION | The owner is responsible for ensuring that the system diagnostic is performed every year. Do not try to use the system if the system diagnostic is failed. |

**Calibration**

To ensure optimal performance of the system, it is important to verify that the system is calibrated.

| CAUTION | The owner is responsible for ensuring that the system calibration is performed after the system installation is completed or the system is repaired. Do not try to use the system if system calibration is not performed. |

**Before exposure**

- Be sure to check the equipment daily and confirm that it works properly.

- Sudden heating the room in cold area will cause condensation to form on the equipment. In this case, wait until the condensation evaporates before performing an exposure. If the equipment is used while the condensation formed on it, problems may occur in the quality of captured image. When an air-conditioner is used, be sure to raise/lower the temperature gradually so that a difference in temperature in the room and in the equipment does not occur, to prevent condensation.

**During exposure**

- Do not use the selected frequency channel for other wireless device. Mutual interference may affect the image data transmission rate.

- Do not use the detector near devices generating a strong magnetic field. Doing so may produce image noise or artifacts.
Electric Shock Hazards

- To reduce the electric shock hazard, the system must be connected to an electrical ground.

- A three-ductor AC power cable is supplied with this system to provide the proper electrical grounding. The power cable must be plugged into an UL-approved three-contact electrical outlet.

- Do not disassemble or modify the product as it may result in fire or electric shock. There are no operator serviceable parts or adjustments inside the systems. Only trained and qualified personnel should be permitted access to the internal parts of the system.

- If an APPLIANCE COUPLER or Mains Plug or other separable plug is used as the isolation means to safety

Disinfection and cleaning

- Wipe it with a dry cloth slightly damed with a neutral detergent.

- Do not use solvents such as alcohol, thinner or benzene. Doing so may damage the surface of the equipment.

- Do not clean the system with turning the power on.

Operating/storage environment

- Be sure to use and store this equipment under the conditions described below:

<table>
<thead>
<tr>
<th></th>
<th>Temperature</th>
<th>Humidity</th>
<th>Atmospheric pressure</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating environment</td>
<td>10 to 35 °C</td>
<td>30 to 85 % RH</td>
<td>700 to 1060 hPa</td>
</tr>
<tr>
<td>Transport &amp; Storage environment</td>
<td>-15 to 55 °C</td>
<td>10 to 90 % RH</td>
<td>500 to 1060 hPa</td>
</tr>
</tbody>
</table>

- Do not expose this equipment to high temperatures and/or high humidity. Malfunction is occur.

- When not in use, keep the detector, handle unit, and grid in a designated location or in a location where they are safe and cannot fall down.

Notes on disposal

- Disposal of this product in an unlawful manner may have a negative impact on health and on the environment. When disposing of this product, therefore, be absolutely sure to follow the procedure which is in conformity with the laws and regulations applicable in your area.

- The expected life span of EVS 3643 system is about 3 years

Handling the equipment

- The equipment must be handle with care to avoid personnel injury or damage to the internal image sensor.
The EVS 3643 Wireless is advanced wireless digital radiographic equipment in the DRTECH Exprimer series. This equipment is designed to provide the highest resolution and sensitivity in the series. In addition, the wireless LAN (IEEE 802.11n*) communication feature improves the operability, and high-speed processing.

2-1. Features

- Wireless LAN communication (IEEE 802.11n*) includes a lightweight and thin detector that is easy to handle.

- The shape of the detector, which is identical to that of a conventional film cassette complying with ISO4090, enables digital radiography in the existing analog radiography configuration

- The new sensor with 140 μm of pixel pitch and CsI (Cesium Iodide) used for the scintillator produces high resolution (approx. 7.86 Mega pixels) digital images within the effective imaging area (358 x 430 mm) with low doses of X-rays

- Depending on the operating conditions at each site, the wiring unit (optional) enables the equipment to be used through expansion to a wired connection

- At the time of installation, set a specific channel in the frequency band of 5.0 GHz before using the LAN. Note that the available frequency band for this standard varies, depending on the local radio laws, regulations and system requirements.

2-2. Intended use

- The EVS 3643 Digital X-ray detector is indicated for digital imaging solution designed for providing general radiographic diagnosis of human anatomy. This device is intended to replace film or screen based radiographic systems in all general purpose diagnostic procedures. This device is not intended for mammography applications
2-3. System Configuration
Generally, the EVS 3643 detector is used in system configuration as illustrated below:

Wireless communication is established between the EVS 3643 Wireless detector and System Control Unit. The EVS-3643 system is compliant with IEEE 802.11a/b/g/n (2.4 GHz / 5 GHz). The available frequency band may vary depending on local radio laws and system requirements. Consult your local dealer for the frequency available in your area.

- Use of multiple WLAN devices within the same frequency band may interference with each wireless communication and cause a decline in transmission speed
- Do not cover or block the wireless module of the detector. Otherwise, the transmission speed or operable distance may be reduced.
- Recommended maximum operating distance of wireless communication between the detector and system synchronization unit is 8 meters.

Figure 2.1 EVS 3643 system configuration
### 3. Product description

EVS 3643 Wireless system consists of detector, system synchronization unit (SSU), CDs and relevant accessories. (Refer to chapter 3-1 “Product Components” for CD information)

<table>
<thead>
<tr>
<th>X-ray Detector (EVS 3643)</th>
<th>System Synchronize Unit (EVS-SSU01) Option</th>
<th>Access Point (D-Link DIR-850L)</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="X-ray Detector" /></td>
<td><img src="image" alt="System Synchronize Unit" /></td>
<td><img src="image" alt="Access Point" /></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>USB Switch Box</th>
<th>Hand Switch</th>
<th>Generator Interface Cable (15m) Option</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="USB Switch Box" /></td>
<td><img src="image" alt="Hand Switch" /></td>
<td><img src="image" alt="Generator Interface Cable" /></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>LAN Cable (Gigabit LAN 10 m)</th>
<th>AC Power Cable (2m) Option</th>
<th>Tether Interface (3 m)</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="LAN Cable" /></td>
<td><img src="image" alt="AC Power Cable" /></td>
<td><img src="image" alt="Tether Interface" /></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Interface Cable(7 m), Option</th>
<th>Power adaptor (12V, 7.08A)</th>
<th>Adaptor cable (3 m) Option</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Interface Cable" /></td>
<td><img src="image" alt="Power adaptor" /></td>
<td><img src="image" alt="Adaptor cable" /></td>
</tr>
</tbody>
</table>
### Table 3.1 EVS 3643 packaging

<table>
<thead>
<tr>
<th>Description</th>
<th>Image 1</th>
<th>Image 2</th>
<th>Image 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Functional cable (0.5 m)</td>
<td><img src="image1.png" alt="Image" /></td>
<td><img src="image2.png" alt="Image" /></td>
<td><img src="image3.png" alt="Image" /></td>
</tr>
<tr>
<td>Battery charger (EVS-BCS)</td>
<td><img src="image1.png" alt="Image" /></td>
<td><img src="image2.png" alt="Image" /></td>
<td><img src="image3.png" alt="Image" /></td>
</tr>
<tr>
<td>Battery pack (EVS-MBP)</td>
<td><img src="image1.png" alt="Image" /></td>
<td><img src="image2.png" alt="Image" /></td>
<td><img src="image3.png" alt="Image" /></td>
</tr>
<tr>
<td>CD(Software / Calibration)</td>
<td><img src="image1.png" alt="Image" /></td>
<td><img src="image2.png" alt="Image" /></td>
<td><img src="image3.png" alt="Image" /></td>
</tr>
<tr>
<td>Manual (Hard Copy)</td>
<td><img src="image1.png" alt="Image" /></td>
<td><img src="image2.png" alt="Image" /></td>
<td><img src="image3.png" alt="Image" /></td>
</tr>
</tbody>
</table>

**DRTECH EVS 3643 System. Safety and Regulatory Information with User’s Manual.**
### 3.1. Product component

<table>
<thead>
<tr>
<th>Item</th>
<th>Product name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Flat panel detector</td>
<td>EVS 3643 (Scintillator: CsI : Tl) 2.98 kg</td>
</tr>
<tr>
<td>System syncronization unit (SSU)</td>
<td>EVS-SSU01 : 2.2 kg Optional</td>
</tr>
<tr>
<td>Battery chaarger and Battery pack</td>
<td>EVS-BCS (charger): 0.5 kg EVS-MBP (battery pack): 0.24 kg</td>
</tr>
<tr>
<td>User’s Manual</td>
<td>Hard Copy</td>
</tr>
<tr>
<td>Accessories</td>
<td>AC Power Cable (2m) Generator Interface Cable (15m, Optional) USB Switch Box Hand switch LAN Cable (10m, Direct, 1000BASE-T) Tether Cable (3m, Optional) Adaptor cable (3m, Optional) Functional cable (0.5 m) Power adapter Interface Cable (7m, Optional) License Dongle Key (USB)</td>
</tr>
</tbody>
</table>

| Table 3.2 Product components |

---

**WARNING**

The use of accessories and cables other than those specified, with the exception of *EVS 3643 Wireless* accessories and cables sold by DRTECH Co., LTD. as replacement parts for internal components, may result in increased emissions or decreased immunity of the equipment. Accessory equipment connected to the analog and digital interfaces must be certified according to the respective IEC standards. All combinations of equipment must be in compliance with IEC 60601-1-1 system requirements. Any person who connects additional equipment to the signal input or signal output ports configures a medical system, and is therefore responsible for ensuring that the system complies with the requirements of the system standard IEC 60601-1. If in doubt, consult DRTECH technical support representative.
3. Product description

Workstation (Recommended and minimum but NOT included)

<table>
<thead>
<tr>
<th>Item</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating system</td>
<td>Windows 7 64 bit SP1 (Professional Edition or higher)</td>
</tr>
<tr>
<td>CPU</td>
<td>Intel Core i5 2600 or higher (or compatible CPU)</td>
</tr>
<tr>
<td>Memory</td>
<td>4GB or higher</td>
</tr>
<tr>
<td>Hard disk</td>
<td>1TB or higher</td>
</tr>
<tr>
<td>LAN card</td>
<td>Gigabit (Detector only)</td>
</tr>
<tr>
<td></td>
<td>Intel® PRO 1000 Series (Gigabit LAN Card for network interface)</td>
</tr>
<tr>
<td></td>
<td>Min. Requirements: 1Gbps,</td>
</tr>
<tr>
<td></td>
<td>Jumbo Frames: 9K</td>
</tr>
<tr>
<td></td>
<td>Receive Descriptors: 2K (higher than 1024)</td>
</tr>
<tr>
<td></td>
<td>This is not dedicated to DICOM</td>
</tr>
<tr>
<td>Monitor</td>
<td>1024 x 768 or higher</td>
</tr>
<tr>
<td>Optional disc drive</td>
<td>CD or DVD R/W</td>
</tr>
</tbody>
</table>

Table 3.3 Workstation

Grid (Recommended but Not included)

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SID</td>
<td>100 / 130 / 150 / 180 cm</td>
</tr>
<tr>
<td>Ratio</td>
<td>8 : 1</td>
</tr>
<tr>
<td>Frequency</td>
<td>215 Line/inch</td>
</tr>
<tr>
<td>Inter spacer</td>
<td>Al</td>
</tr>
</tbody>
</table>

Table 3.4 Grid specifications

3-2. X-ray Imaging condition

X-ray Energy Range

40kVp ~ 150kVp

Reliability (Lifetime Dose)

More than 74Gy (35uGy x 365days x 24hours x 60minutes x 60seconds/15sec)
## 4-1. Detector specification

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Model</td>
<td>EVS 3643</td>
</tr>
<tr>
<td>Purpose</td>
<td>General Radiography</td>
</tr>
<tr>
<td>Pixel Pitch</td>
<td>140 um</td>
</tr>
<tr>
<td>Scintillator</td>
<td>CsI (Cesium Iodide)</td>
</tr>
<tr>
<td>Image Matrix Size</td>
<td>$2560 \times 3072$ pixels</td>
</tr>
<tr>
<td>Effective Imaging Area (H x V)</td>
<td>$358 \times 430$ mm</td>
</tr>
<tr>
<td>Image Acquisition and Transfer Time</td>
<td>$&lt; 3$ sec.</td>
</tr>
<tr>
<td>Spatial Resolution</td>
<td>Min. 3.5 line pair/mm</td>
</tr>
<tr>
<td>Rated Power Supply</td>
<td></td>
</tr>
<tr>
<td>Wireless</td>
<td>DC $+12$V $2 \text{ A}$</td>
</tr>
<tr>
<td>Powered by the battery pack (4,000 mA h)</td>
<td></td>
</tr>
<tr>
<td>Wired</td>
<td>Powered by SSU using tether interface</td>
</tr>
<tr>
<td>Powered by Power adopter using tether interface</td>
<td></td>
</tr>
<tr>
<td>Power Consumption</td>
<td>Max. $24$ W</td>
</tr>
<tr>
<td>Network Interface</td>
<td>14 bit Digital Output Ethernet (1000BASE-T)</td>
</tr>
<tr>
<td>Dimensions (mm)</td>
<td>$386$ (H) $\times$ $460$ (V) $\times$ $14$ (D)</td>
</tr>
<tr>
<td>Weight</td>
<td>$2.98$ kg</td>
</tr>
</tbody>
</table>

### Environmental Requirements

| Operation                  | Temperature: $+10 \sim +35^\circ$C                  |
|                          | Humidity: $30 \sim 85\%$ RH (Without Condensing)      |
|                          | Atmospheric pressure: $700 \sim 1060$ hPa             |
| Storage and Transportation(unpacked) | Temperature: $-15 \sim +55^\circ$C                  |
|                          | Humidity: $10 \sim 90\%$ (Without Condensing)        |
|                          | Atmospheric pressure: $500 \sim 1060$ hPa            |

Table 4.1 Detector specifications

†Tether Interface: Allows the detector to communicate with SSU via Ethernet cabling when wireless communications is not available or higher speed data transfer is necessary
4-2. Detector component

The detector is designed to capture radiographic images. Captured images are transmitted to the EVS 3643 image-capture computer using the wireless/wired data transfer.

![Detector components diagram]

Figure 4.1 Detector components

A. Wireless antenna: Transmits image data with wireless communication (IEEE802.11n).
B. Battery Pack: Supplies electric power to the detector while communication wirelessly.
C. Status indicators
   - AP: Alter button for Wired/Wireless (2.4 GHz / 5 Hz)
   - Link: Shows detector registration and connection status.
   - Ready: Shows data communication status.
   - Power: Shows power on/off status of the detector.

   - Simultaneous blinking of two or more LED lamps indicates a system error.
D. AP Button: registration detector.
E. Power Button: Detector power on / off
F. Connector: Data communication and power supplying through tether cable
4-3. Detector dimension

Figure 4.2 Detector dimension
4-4. Power supply and SSU (System synchronization unit)

4-4-1 SSU Specifications

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Model</td>
<td>EVS-SSU01</td>
</tr>
<tr>
<td>Power Supply</td>
<td>Input: AC100 to 240V, 50/60Hz Output: DC +12V 8.3A, 75W</td>
</tr>
<tr>
<td>Dimensions (W x H x D)</td>
<td>260 mm x 248 mm x 49 mm</td>
</tr>
<tr>
<td>Weight</td>
<td>2.2 kg</td>
</tr>
</tbody>
</table>

### Environmental Requirements

<table>
<thead>
<tr>
<th>Operation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Temp: +10 ~ +35°C</td>
<td>Humidity: 30 ~ 85% RH (Without Condensing)</td>
</tr>
<tr>
<td>Humidity: 30 ~ 85% RH</td>
<td>Atmospheric pressure: 700 ~ 1060 hPa</td>
</tr>
<tr>
<td>Altitude: Max. 2 km</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Storage and Transportation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Temp: -15 ~ +55°C</td>
<td>Humidity: 10 ~ 90% (Without Condensing)</td>
</tr>
<tr>
<td>Humidity: 10 ~ 90%</td>
<td>Atmospheric pressure: 500 ~ 1060 hPa</td>
</tr>
<tr>
<td>Altitude: Max. 2 km</td>
<td></td>
</tr>
</tbody>
</table>

Table 4.2 System synchronization unit specifications
4-5. Battery Charger and Battery Pack

4-5-1 Battery Charger

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Model</td>
<td>EVS-BCS</td>
</tr>
<tr>
<td>Simultaneous Charging</td>
<td>Battery Pack 2 EA</td>
</tr>
<tr>
<td>Charging Time</td>
<td>3 hours</td>
</tr>
<tr>
<td>Rated Power Supply</td>
<td>DC +12 V, 6 A Max.</td>
</tr>
<tr>
<td>Dimensions (W x H x D)</td>
<td>180 mm x 255 mm x 35 mm</td>
</tr>
<tr>
<td>Weight</td>
<td>0.5 kg</td>
</tr>
</tbody>
</table>

Table 4.3 Battery charger specifications

4-5-1-1 Battery charger components

- A. Power indicator: indicates the power on/off status.
- B. Charging indicator: Indicates the charging status.
- C. Battery compartment: Insert the battery pack to charge.
- D. DC Input: Connect the DC adapter to supply electrical power to the battery charger

Figure 4.4 Battery charger
4-5-1-2 Battery charger dimension

Unit : mm

Figure 4.4 Battery charger system
4-5-2 Battery Pack specification

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Model</td>
<td>EVS-MBP</td>
</tr>
<tr>
<td>Cell Type</td>
<td>Lithium Polymer</td>
</tr>
<tr>
<td>Number of Cell</td>
<td>2S1P (2series 1 Parallel)</td>
</tr>
<tr>
<td>Rated Power Supply</td>
<td>Output : DC +7.4 V</td>
</tr>
<tr>
<td>Life</td>
<td>Approx. 500 times (charge / discharge 1 cycle)</td>
</tr>
<tr>
<td>Dimensions (W x H x D)</td>
<td>163 mm x 148 mm x 7 mm</td>
</tr>
<tr>
<td>Weight</td>
<td>0.24 kg</td>
</tr>
</tbody>
</table>

Table 4.5 Battery charger specifications

4-5-2-1 Battery charger components

A. Charging indicator : Indicates the charging status
B. Latch knob : rotating on /off for battery swap

Figure 4.5 Battery pack
4-5-1-2 Battery pack dimension

Unit: mm

Figure 4.6 Battery pack dimension
4-5-3 Charging Battery Pack

The battery pack supplies power to the detector during wireless connection. Be sure to use only the dedicated battery pack and fully charge it before use.

- Connect the power adapter to the DC Input port of the battery charger. The power LED lights in blue indicating the presence of direct current (DC) power.
- Insert the battery pack into the battery charger. Charging starts automatically. The charge LED lights green when the battery pack is being charged. After the battery pack is charged completely, all level of the charge LED will go to luminance.
- Gently pull the charged battery pack to remove from the battery charger.

| WARNING | Securely plug the power cord into the power source. If contact failure occurs, or if dust or metal objects come into contact with the exposed metal prongs of the plug, fire or electrical shock may occur. |
| CAUTION | Be sure to stop charging the battery pack when the charge LED lights in green beyond the specified charging time. Not doing so may result in battery pack overheating or smoking or in explosion or fire. |
| CAUTION | You must use the power adaptor that is certified with IEC 60950 or IEC 60601-1. |
| | Two batteries can be charged at the same time. |
| | It takes approximately two hours to fully charge a battery pack. The required charging time may vary depending on the temperature and remaining battery level. |
4-6 Wireless access point(Optional)

This antenna equipment relays captured images from the detector to the control system. No operation is required for this equipment while using the EVS Digital Radiography system.

4-5-1 Access point Specifications

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Model</td>
<td>D-Link DIR-850L</td>
</tr>
<tr>
<td>Power</td>
<td>DC 12V/2A</td>
</tr>
<tr>
<td>Communications</td>
<td>IEEE 802.11n/g(2.4 GHz), IEEE 802.11ac/n/a (5GHz)</td>
</tr>
<tr>
<td>Dimensions</td>
<td>85.73 x 111.13 x 145.28 mm</td>
</tr>
<tr>
<td>Weight</td>
<td>0.28 kg</td>
</tr>
</tbody>
</table>

Environmental Requirements

- **Operation**
  - Temperature: 0 ~ +40 °C
  - Humidity: 10 ~ 90% RH (Without Condensing)

CAUTION

Do not use the wireless access point within the patient’s vicinity
The EVS 3643 Detector is properly adjusted at installation by the service engineer. If you encounter any problems during normal operation or daily inspections, consult your sales representative or local DRTECH dealer.

## General workflow

The following workflow indicates the procedures after startup of the EConsole1 and other system equipment:

### 5-1. Preparing to use the detector

1. Attach a fully-charged battery pack to the detector.

### 5-2. Operating the detector

1. Turn on the detector
2. Register the detector and make connection to the EConsole1 power supply to the detector

### 5-3. Conduct Examination

- Select or register the patient information
- Select the protocol (selection of the detector)
- Arrange the patient in the correct posture
- Position the X-ray generator to adjust the exposure field
- Check all the conditions
- Check the captured images
- List the images
- Transmit the images

**Loop back procedure for each patient**

**Loop back procedure for each body part**

Sterilize the portion of the detector that has been in contact with a patient

**For details, refer to the operation manual or setup guide of the EConsole1**

### 5-3. Ending use of the detector

1. Turn off the detector
2. Remove the battery pack
5-1. Preparing to use the detector

**CAUTION**

Be sure to use only the dedicated power supply for the EVS-3643 detector

Standard Configuration

Configuring with SSU (power supply) to the detector

Make sure that the cable is placed to the connector (detector side)

---

5-2. Operating detector

1. **Turn on the detector**

   - Before operating the detector, start up the EConsole1
   - Press and hold the POWER button (approx. 1 second)
   - Power lamp (Blue) light up
2 Register the detector and make connection to the EVS control system

Registration
Press and release the AP button
Link lamp flashes.

When the AP Lamp flashes 1 time in 2sec, wired mode status has showing.
When the AP Lamp flashes 2 times in 2sec, wireless (2.4 GHz) mode status has showing.
When the AP Lamp flashes 3 times in 2sec, wireless (5 GHz) mode status has showing.

Connection
Network connection between the internal wireless module of the detector and the wireless access point/EVS control system is secured automatically
The link lamp lights up when the detector is registered and the communication connection is established
The LINK lamp does not light up when the detector is not registered or the communication connection is not established.
When the Ready and LINK Lamp flash, a communication error has occurred. See Troubleshooting.

3 Conduct examination

For details about operation, refer to the Operation Manual for the ECali1.

i) Select the patient information or protocols on the screen and start the examination.
The READY lamp flashes during preparation for examinations.

The READY lamp lights up when the detector and EConsole1 change to exposure ready status.

- Arrange the patient in the correct posture and position the detector aligning it with the target body part.
- Position the X-ray generator to adjust the exposure field.
- Check all conditions before exposure.

Make sure that four LED lamps (POWER, READY, LINK, AP) are lit. This means that the system is ready to start an examination.

A communication error has occurred when two or more lamps flash.

When the READY lamp (green color) flashes slowly, the detector is in detector selection status (Sleep).

The detector enters detector selection status automatically when it has not been used for a certain period of time.

ii) Press the exposure switch of the X-ray generator.
    Images captured with the detector are transmitted to the EConsole1 and appear on the monitor.
    - Check the images on the monitor.
    - If any uncompleted protocols remain, repeat the procedure ii).

ii) Click the button for ending the examination images are stored automatically
    - To conduct examination for another patient, repeat the step 3.

**IMPORTANT**
Sterilize the portion of the detector that has been in contact with a patient to prevent infection.
A signal strength indicator appears on the screen of the ECali1 computer. It shows the wireless communication level between the detector and the ECali1. Keep the wireless communication level stable on capturing or transmitting images.

<table>
<thead>
<tr>
<th>Display</th>
<th>Signal strength (communication stability)</th>
<th>Status</th>
<th>Required actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>![signal_strength]</td>
<td>Very high (Stable)</td>
<td>Normal</td>
<td>-</td>
</tr>
<tr>
<td>![signal_strength]</td>
<td>High (Stable)</td>
<td>Normal</td>
<td>-</td>
</tr>
<tr>
<td>![signal_strength]</td>
<td>Low (Unstable)</td>
<td>Unstable communication. Comunication speed is lowered</td>
<td>Check whether there is any obstacle (e.g., your hands) between the wireless module and the wireless access point. If there is any obstacle, remove it. If the problem cannot be resolved, consult your sales representative or local DRTECH dealer</td>
</tr>
<tr>
<td>![signal_strength]</td>
<td>No signal (Communication failed)</td>
<td>Cannot communicate</td>
<td>Confirm that detector and the access point are turned on. If the problem cannot be resolved, consult your sales representative or local DRTECH dealer</td>
</tr>
</tbody>
</table>
5-3. Ending use of the detector

Turn off the detector

Press the SSU POWER button.
All the LED lamps are off.

Detector status list

<table>
<thead>
<tr>
<th>Lamp type</th>
<th>Power Lamp</th>
<th>Ready Lamp</th>
<th>Link Lamp</th>
<th>AP Lamp</th>
</tr>
</thead>
<tbody>
<tr>
<td>Color</td>
<td>[Blue]</td>
<td>[Green]</td>
<td>[Orange]</td>
<td>[Green]</td>
</tr>
<tr>
<td>Power ON</td>
<td>○</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>During detector registration</td>
<td>○</td>
<td>x</td>
<td>☆</td>
<td>☆</td>
</tr>
<tr>
<td>Detector registration completed (1 Sec,)</td>
<td>○</td>
<td>o</td>
<td>☆</td>
<td>o</td>
</tr>
<tr>
<td>Communication established</td>
<td>○</td>
<td>x</td>
<td>o</td>
<td>☆</td>
</tr>
<tr>
<td>During exposure preparation</td>
<td>○</td>
<td>x</td>
<td>☆</td>
<td>o</td>
</tr>
<tr>
<td>Ready status or performing an examination (Ready)</td>
<td>○</td>
<td>o</td>
<td>-</td>
<td>o</td>
</tr>
<tr>
<td>Detector selection status (Sleep)</td>
<td>○</td>
<td>★</td>
<td>-</td>
<td>o</td>
</tr>
<tr>
<td>During image data transmission</td>
<td>○</td>
<td>o / ★</td>
<td>-</td>
<td>★</td>
</tr>
<tr>
<td>Power OFF</td>
<td>x</td>
<td>x</td>
<td>-</td>
<td>x</td>
</tr>
</tbody>
</table>

○ : Light on       ☆ : Flashes (On/Off status changes every second)

x : Lights off      ★ : Flashes slowly (On/Off status changes every 2 seconds)

- : Unspecified status
6-1. Using the wireless detector with other EVS series detectors in a same system

The ECali1 with the EVS 3643 detector enables connection with EXPRIMER series detectors other than that EVS 3643 detector, according to preset settings. Select a detector when conducting an examination. For details, consult your sales representative or local DRTECH dealer.
6-2. Sharing the detector among different systems

The EVS 3643 detector can be used in two or more systems in which protocols for the detector have already been preset. For details, consult your sales representative or local DRTECH dealer.
6-3. AED mode

- AED mode can make exposure as using internal storage in the detector without a wireless connection.
- The images can be transmitted to a PC and used by connecting the detector to Viewer. The transmitting images in the detector are removed automatically.
- Image processing and correction are available after connecting the detector to Viewer.

![EVS 3643 Detector](image)

Figure 6.3 AED mode
6-4. Wiring connections

The EVS 3643 detector has a cable connector. With the wiring unit (optional), it is possible to expand from a wireless configuration to a wired configuration (see the figure below). Wired configuration is suitable for use where the detector is set in a Bucky stand and table in place of a film cassette. In this configuration, for the reason that data communication and power supply are made via a cable, users do not have to be concerned about power and wireless communication failure. This reduces the time and labor involved in charging and replacing.

Figure 6.4 Wiring connection with SSU

Figure 6.5 Wiring connection with USB S/W BOX

For details about wired configuration, consult your sales representative or local DRTECH dealer.
7-1. Hardware Installation

This section describes how to connect the EVS 3643 system (Detector)

CAUTION

Installation of this equipment should be made by licensed and authorized personnel.

1 Connect the one end of the generator interface cable to the X-ray port of SSU, and the other to the port of the x-ray generator.
2 Connect the LAN cable to PC port of SSU, and the other to the LAN Card connector of workstation assigned for the data transfer

3 To transmit image data and connect power with Tether Interface, connect the Tether interface cable to FPD 1 or FPD 2 of SSU
4 Connect the power cable to the AC port of the SSU to supply power

| CAUTION | This equipment must only be connected to a main power with protective earth |

5 Turn on the power switch in the front of the SSU
7-2. ECali1 Installation

7-2-1 System Requirements

Table 7.1. System requirement

<table>
<thead>
<tr>
<th>Items</th>
<th>Minimum</th>
<th>Recommended</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU</td>
<td>Intel i3-2100</td>
<td>Intel i5-3470</td>
</tr>
<tr>
<td>RAM</td>
<td>2 GB</td>
<td>4 GB</td>
</tr>
<tr>
<td>HDD</td>
<td>100 GB</td>
<td>500 GB</td>
</tr>
<tr>
<td>VGA</td>
<td>Intel HD GRAPHIC 2000</td>
<td>NVIDIA GeForce GT630 1GB</td>
</tr>
<tr>
<td>ODD</td>
<td>CD-ROM</td>
<td>DVD Recorder</td>
</tr>
<tr>
<td>OS</td>
<td>Windows XP Pro SP2</td>
<td>Windows 7 Pro 32 / 64bit</td>
</tr>
<tr>
<td>Display Size</td>
<td>17 inch</td>
<td>23 inch</td>
</tr>
<tr>
<td>Display Resolution</td>
<td>1024 x 768</td>
<td>1920 x 1080</td>
</tr>
</tbody>
</table>

Efficient operation is not guaranteed for PCs that do not comply with the recommended specification.

7-2-2 Installation & Removal

Installation prerequisites

Windows 7

Windows 7 users must set the User Account Control (herein after ‘UAC’) permission and disable the firewall.

1) UAC Setting

① Click the start icon

② Click ‘Control Panel’

③ Select ‘User Accounts’

④ In the User Accounts window, click ‘User Accounts’

⑤ In the User Accounts task window, click ‘Change User Account Control Setting’

⑥ Adjust the slider to the ‘Never notify,’ and then click ‘OK’.
2) Disabling the Firewall

① Click the Start icon
② Click ‘Control Panel’
③ Click ‘Security’
④ Click ‘Windows Firewall’
⑤ Click ‘Turns Windows Firewall on or off’ on the left
⑥ Click ‘Off (not recommended),’ and then click ‘OK’

✓ Windows 8

Windows 8 users must set the User Account Control (herein after ‘UAC’) permission, Disable the firewall and run the program as the system administrator.

3) UAC Setting

① Click ‘Setting’ on the right hand menu
② Click ‘Control Panel’
③ Select ‘User Accounts’
④ In the User Accounts window, click ‘User Accounts’
⑤ In the User Accounts task window, click ‘Change User Account Control Setting’
⑥ Adjust the slider to the ‘Never notify,’ and then click ‘OK’

4) Disabling the Firewall

① Click ‘Setting’ on the right hand menu
② Click ‘Control Panel’
③ Click ‘Security’
④ Click ‘Windows Firewall’
⑤ Click ‘Turns Windows Firewall on or off’ on the left
⑥ Click ‘Off (not recommended),’ and then click ‘OK’

5) Run as Administrator

Windows 8 users must run the Installation File and Program as the Administrator
Install the program by right clicking (press and hold, if touch screen) and selecting ‘Run as Administrator’

After completing the installation, set the icon, so that it always runs as administrator
7. How to Install

7-1-3. Installation

Run the provided setup file.

Figure 7.1. ECali1 Setup File

- At least 2GB of available HDD space is required for the proper installation of ECali1!

- Windows 8 users must run the file as ‘administrator’.

Right-click the file, select ‘Run as administrator’ in the menu.

Figure 7.2. Setup Wizard Window
7. How to Install

Figure 7.3. ① Language & ② Number of Detector Setting

Figure 7.4. Setting of the Model of the First Detector
7. How to Install

Figure 7.5. Installation Path Setting

Figure 7.6. Start Menu Folder Selection
7. How to Install

**Figure 7.7. Additional Task Setting**

![Select Additional Tasks](image1)

**Figure 7.8. Verification of Settings**

![Ready to Install](image2)
7. How to Install

Figure 7.9. Installation Window

Figure 7.10. Installation Window
7. How to Install

Figure 7.11. Installation Window

Figure 7.12. Installation Window
7-1-4 Settings Post Installation

1) Windows 8 users must set ECali1 so that it runs as administrator.
   ① Right click (press and hold) the ‘ECali1.exe’ in the installation destination (in C:\Cali1 by default).
   ② Click ‘Properties’.
   ③ Select ‘Advanced’ in the ‘Shortcut’ tab.
   ④ Check the ‘Run as administrator’ box, then click ‘OK’

7-1-5 IP Address Configuration

It is required when using a EVS 3643 detector using an Ethernet Interface.
The IP Address of the Network Adapter connected with the EVS 3643 Detector System installed on the PC should be configured.


![Figure 7.13. IP Address Configuration]

- ② IP Address: 192.168.250.XXX
  - For F600: 192.168.250.100
  - Others: 1 ≤ XXX ≤ 254 (Excluding 150 and 200)
- ③ Subnet mask: 255.255.255.0
7-1-6 Uninstall ECali1

1) Click ‘Uninstall ECali1’ in Windows start menu – All Programs - ECali1

![Uninstall ECali1](image1)

Figure 7.14. Uninstall ECali1

2) Click ‘Yes’ and proceed with uninstall when a window appears verifying the removal of the program.

![Uninstall ECali1](image2)

Figure 7.15. Uninstall ECali1
7-2 ECali1 Operation & Detector Integration

7-2-1 Program Start-up

In order to run the program, you can select ECali1 in Windows Menu – All Programs – ECali1 Folder, or by double clicking ECali1.exe in C:\ECali1 (or the customized installation path)

![ECali1 Start-up](image1)

**Note**

→ An error notification as in Figure 7.17. Pixel / Gain map File Notification) will be presented during the initial start-up of the program.

→ It is a normal notification informing the absence of Pixel map file and Gain map file, so proceed by clicking 'OK'.

![Pixel / Gain map File Notification](image2)

**Note**

Please install the additional software in accordance with the specification of your OS if the program does not operate after proper installation.

**For Windows XP SP3, Windows 7, and Windows 8:**

- VC2008SP1 Runtime (vcredist_x86.exe)

**For Windows XP SP2:**

- Wireless LAN API package
- Microsoft Core XML Service (MSXML) 6.0
- VC2008SP1 Runtime (vcredist_x86.exe)
7. How to Install

For Windows XP SP1 or earlier OS:

- ECali1 will only operate in Windows XP SP2 and later environments. Please install Service Pack 2 or 3 if you are using Windows XP.
- We do not guarantee proper operation of ECali1 in OS earlier than Windows XP

7-2-2 Detector Connection

1) The Detector which will be utilized should be registered prior to operating the program.
2) A Registration and Configuration window for the Detector will appear during the initial start-up of the program.
3) This configuration window is available through Configuration in the Option menu, and please refers to 1) Detector Configuration for detailed information.

![Figure 7.18. Detector Registration](image)

- ⑥ displays the registered Detector.
- If a specific item requires editing, select the Model to be edited in ① and click ④ Edit.
- Select a Model in ① and click ③ Add in order to add a Detector.
- The most recently registered model will be deleted if ⑤ Delete is selected.
✓ Changes in configurations must be saved.

✓ Save the changes in configuration by selecting the save icon below

![Configuration Save Icon](image)

**Figure 7.19. Configuration Save icon**

✓ When the save button is selected, a program restart message will appear. Restart the program by selecting ‘OK’.
✓ Verify Detector Connection after restarting the program.

✓ Open the ‘Log’ tab after connecting and powering on all necessary devices including the Detector.

Figure 7.20. Detector Connection Log

✓ The Detector has been successfully integrated if a ‘Ready to Capture!’ appears in the window as seen in the figure.
7-3 Grid Configuration

1) Grid type must be configured for each registered Detector.

2) The Grid type is set as ‘None’ by default, so this step may be skipped if a Grid isn’t used.

3) Grid configuration may be completed in the ‘Detector #’ tab.
   # will be designated with alphabets of A, B, C, ...

4) Please verify the Model and Grid of the registered Panel since a limited number of Detectors may use the Grid with the use of multiple Detectors.
5) Filter file must be registered after the configuration of Type.

![Registering Grid Filter File](image)

**Figure 7.22. Registering Grid Filter File**

① Select the Filter file by selecting ‘...' as in the figure.
② A file compatible with the configured Grid Type must be selected.
③ Filter file is located in the `[ECal1 Installation Folder]\Filter` Folder.
④ It is in the `C:\ECal1\Filter` folder by default.

![Filter File](image)

**Figure 7.23. Filter File**

6) **Input the ① Lines/Inch and ② Angle in accordance with the Grid Type.** The ⑤ cm to Inch button may be utilized to alter the units when entering the Lines/Inch, if the cm unit is known.
7) Save and restart the program after completing the configuration.
7-4 Map File Registration

Open the configuration tab for each registered Detector though Option Menu – configuration and opening the Configuration window.

![Figure 7.25. MAP File Destination Configuration](image)

Use the ‘…’ on the right or manually enter in a new directory to change the destination name. **Please set it as a file used or provided by the X-ray acquisition software.**

Save the changes in configuration using the save button below after designating a destination for all registered Panels.

![Figure 7.26. Save Button](image)

ECali1 will automatically restart when the changes in configuration has been saved.
7-5 ECal1 UI Overview

7-5-1 Main Screen of the Program

The main screen of ECal1 is as illustrated in [7.27].

![Main Screen of ECal1](image)

**Figure 7.27. Main Screen of ECal1**

<table>
<thead>
<tr>
<th>Category</th>
<th>Title</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>a</td>
<td>Menu</td>
<td>Menu (p. 49)</td>
</tr>
<tr>
<td>b</td>
<td>Toolbar</td>
<td>Toolbar (p. 53)</td>
</tr>
<tr>
<td>c</td>
<td>Pixel Map Toolbar</td>
<td>Pixel Map Toolbar and Pixel Viewer (p. 66)</td>
</tr>
<tr>
<td>d</td>
<td>Thumbnail</td>
<td>Thumbnail (p. 67)</td>
</tr>
<tr>
<td>e</td>
<td>Image Viewer</td>
<td>Image Viewer (p. 68)</td>
</tr>
<tr>
<td>f</td>
<td>Pixel Viewer</td>
<td>Pixel Map Toolbar and Pixel Viewer (p. 66)</td>
</tr>
<tr>
<td>g</td>
<td>Mini Map / Pixel Value</td>
<td>7-7 Mini Map and Pixel Value (p. 70)</td>
</tr>
<tr>
<td>h</td>
<td>Histogram</td>
<td>Histogram (p. 71)</td>
</tr>
<tr>
<td>i</td>
<td>Status Bar</td>
<td>Status Bar (p. 72)</td>
</tr>
</tbody>
</table>
1) Menu

Corresponds to ③ in [Figure 7.27] and comprised of 5 menus, which are File, Tools, Option, Detector and Help.

A. File Menu

Figure 7.28. File Menu

Table 7.1. File Menu Descriptions

<table>
<thead>
<tr>
<th>Menu</th>
<th>Descriptions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Load pixel map</td>
<td>Loads the Pixel map file.</td>
</tr>
<tr>
<td>Save pixel map</td>
<td>Saves the Pixel map file.</td>
</tr>
<tr>
<td>Load gain map</td>
<td>Loads the Gain map file.</td>
</tr>
<tr>
<td>Load panel map</td>
<td>Loads the Panel map file.</td>
</tr>
<tr>
<td>Load raw image</td>
<td>Loads the RAW image file in .IMG(^1) format.</td>
</tr>
<tr>
<td>Save raw image</td>
<td>Saves the currently selected image as a RAW image file in .IMG format.</td>
</tr>
<tr>
<td>Exit</td>
<td>Exits ECali1.</td>
</tr>
</tbody>
</table>

\(^1\) .IMG file: Image Data file that has 16 bit gray-level pixel value
### B. Tools Menu

#### Figure 7.29. Tools Menu

**Table 7.2. Tools Menu Descriptions**

<table>
<thead>
<tr>
<th>Menu</th>
<th>Descriptions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gain map calibration</td>
<td>Initiates the Gain Map Calibration. Please refer to 7-10 Gain Calibration for more details.</td>
</tr>
<tr>
<td>Create FGain map</td>
<td>Generates a Filtered Gain Map² using the currently loaded Gain Map. Will not operate if the loaded Gain Map is a Filtered Gain Map. The generated Filtered Gain Map is saved in the configured Gain Map destination of the Detector (Panel) set in Configuration.</td>
</tr>
<tr>
<td>Filter calibration</td>
<td>Run the Grid Filter Calibration task. Please refer to 오류! 참조 원본을 찾을 수 없습니다.. 오류! 참조 원본을 찾을 수 없습니다. for more details.</td>
</tr>
<tr>
<td>Filter calibration using files</td>
<td>Run the Grid Filter Calibration using raw files. Please refer to 오류! 참조 원본을 찾을 수 없습니다.. 오류! 참조 원본을 찾을 수 없습니다. for more details.</td>
</tr>
<tr>
<td>Scale Fit</td>
<td>Adjusts the magnifying ratio of the image displayed in the Image Viewer domain.</td>
</tr>
<tr>
<td>Scale 1:1</td>
<td>Adjusts the magnifying ratio of the image displayed in the Image Viewer domain to set the size of the image corresponding to its actual size. The Pixel displayed on the screen will be identical to the actual Pixel of the Detector.</td>
</tr>
<tr>
<td>Fixed Scale</td>
<td>Saves the configured scale ratio in the current Image Viewer and applies it to the subsequent images.</td>
</tr>
</tbody>
</table>

---

² Filtered Gain Map: Gain Map maintaining the uniformity of the image even if the uniformity of the X-ray source is different, by applying filtering to the Gain Map
## C. Option Menu

![Option Menu](image)

Table 7.3. Option Menu Descriptions

<table>
<thead>
<tr>
<th>Menu</th>
<th>Descriptions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuration</td>
<td>Opens the Configuration window. Please refer to 7-12 Configuration for more details regarding Configuration.</td>
</tr>
<tr>
<td>Engineer Mode</td>
<td>Initiates Engineer Mode of ECali1 for Advanced Configuration. Requires the input of a password.</td>
</tr>
<tr>
<td>Terminal Mode</td>
<td>Initiates the Terminal Emulator which allows the internal configuration of the Detector.</td>
</tr>
<tr>
<td>Remove grid ON/OFF</td>
<td>Sets the Grid Pattern Algorithm application. If a check mark (✓) is available as noted in the figure, the algorithm is applied (ON). This category must be ON if Grid is utilized.</td>
</tr>
<tr>
<td>AED – Acq mode</td>
<td>Activates AED mode to allow image acquisition.</td>
</tr>
<tr>
<td>AED – Stay mode</td>
<td>Inactivates AED mode and reverts to Standby.</td>
</tr>
<tr>
<td>Ready</td>
<td>Converts the status of the Detector to Ready.</td>
</tr>
<tr>
<td>Exposure</td>
<td>The Detector performs Exposure.</td>
</tr>
<tr>
<td>Ready cancel</td>
<td>Cancels the Ready status of the Detector and reverts to Standby.</td>
</tr>
</tbody>
</table>
D. Detector Menu

![Detector Menu]

① Select the active Detector from the registered Detector (Panel).
② Number of Menus reflecting the number of registered Detectors through Option – Configuration - General will be generated. Only one Detector may be selected

E. Help Menu

![Help Menu]

Table 7.5. Help Menu Descriptions

<table>
<thead>
<tr>
<th>Menu</th>
<th>Descriptions</th>
</tr>
</thead>
<tbody>
<tr>
<td>About</td>
<td>Will display the version information of ECali1.</td>
</tr>
<tr>
<td>Check update</td>
<td>* Requires internet connection. Checks and installs updates for ECali1.</td>
</tr>
</tbody>
</table>
7-5-2 Toolbar
Corresponds to \(\textcircled{5}\) in [7.27] and provides most used menus as Toolbar icons.

![Figure 7.33. Toolbar](image)

<table>
<thead>
<tr>
<th>Icon Descriptions</th>
<th>Table 7.6. Toolbar Icon Descriptions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Performs Gain map calibration. Corresponds to the Gain map calibration in the Tools Menu.</td>
<td><img src="image" alt="Icon" /></td>
</tr>
<tr>
<td>Performs Grid Calibration. Corresponds to the Grid map calibration in the Tools Menu.</td>
<td><img src="image" alt="Icon" /></td>
</tr>
<tr>
<td>Loads and applies the Pixel map file. Corresponds to the Load pixel map in the File Menu.</td>
<td><img src="image" alt="Icon" /></td>
</tr>
<tr>
<td>Stores the currently applied Pixel map as a file. Corresponds to the Save pixel map in the File Menu.</td>
<td><img src="image" alt="Icon" /></td>
</tr>
<tr>
<td>Loads and applies the Gain map file. Corresponds to the Load Gain map in the File Menu.</td>
<td><img src="image" alt="Icon" /></td>
</tr>
<tr>
<td>Loads and displays the projected image from the file. Corresponds to the Load raw image in the File Menu.</td>
<td><img src="image" alt="Icon" /></td>
</tr>
</tbody>
</table>
### 7. How to Install

<table>
<thead>
<tr>
<th>Image</th>
<th>Stores the currently projected image as a file. Corresponds to the Save raw image in the File Menu.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remove grid</td>
<td>This category must be ON when using the Grid. Corresponds to the Remove grid ON/OFF in the Tools Menu.</td>
</tr>
<tr>
<td>Scale</td>
<td>Adjusts the magnifying ratio of the image in @ to fit on screen. Corresponds to the Scale Fit in the Tools Menu.</td>
</tr>
<tr>
<td>Scale</td>
<td>Adjusts the magnifying ratio of the image in @ to actual size of the image. Corresponds to the Scale 1:1 in the Tools Menu.</td>
</tr>
<tr>
<td>Acq. Mode</td>
<td>* Only available when the selected Detector (Panel) supports AED mode. * Only available when AED mode is active. Changes the status of the Detector to acquire images. Corresponds to the AED - Acq mode in the Options Menu.</td>
</tr>
<tr>
<td>Acq. Mode</td>
<td>* Only available when the selected Detector (Panel) supports AED mode. * Only available when AED mode is active. Converts the Detector to Standby mode. Corresponds to the AED - Stay mode in the Options Menu.</td>
</tr>
<tr>
<td>AED/Switch</td>
<td>* Only available when the selected Detector (Panel) supports AED mode. This category must be activated when using AED mode.</td>
</tr>
</tbody>
</table>
7-5-3 Pixel Map Toolbar and Pixel Viewer

Corresponds to ⑥ and ⑦ in [Figure 7.27], and utilized when creating a Pixel Map.

The selected area from the Image Viewer will be magnified and displayed in the Pixel Viewer. Please refer to 7-11 Pixel Correction for more details and methods of generating Pixel Maps.
7-5-4  Thumbnail

Corresponds to @ in [Figure 7.27].

Displays the Thumbnail of the projected image, and allows the user to select a specific image between multiple images.

If there are a significant number of projected images, a scroll button on the top and bottom allows the user to select a specific image.

Select the Thumbnail to be deleted and select ‘Delete’ if a re-projection is required during the calibration. The selected image will be deleted and a re-projection may be performed.

The following information will be displayed if an image is loaded from a file.

- The file name will be displayed on the top left.
- STD: Standard Deviation Value of the Pixel value of the image.
- Mean: Mean value of the pixel value of the image.
7-6 **Image Viewer**

Corresponds to ☰ in [Figure 7.27].

![Image Viewer](image.png)

*Figure 7.38. Image Viewer*
Displays the projected image and supports the following functions.

**Table 7.7. Image Viewer Function & Control Method**

<table>
<thead>
<tr>
<th>Function</th>
<th>Control Method</th>
</tr>
</thead>
<tbody>
<tr>
<td>Magnify</td>
<td>Roll the mouse wheel forward in the Image Viewer.</td>
</tr>
<tr>
<td>Reduce</td>
<td>Roll the mouse wheel backwards in the Image Viewer.</td>
</tr>
<tr>
<td>Move Image</td>
<td>Left click, drag and drop the image in the Image Viewer.</td>
</tr>
<tr>
<td>W/L³ Width Increase</td>
<td>Drag the right mouse button down.</td>
</tr>
<tr>
<td>W/L Width Reduction</td>
<td>Drag the right mouse button up.</td>
</tr>
<tr>
<td>W/L Left Shift</td>
<td>Drag the right mouse button left.</td>
</tr>
<tr>
<td>W/L Right Shift</td>
<td>Drag the right mouse button right.</td>
</tr>
<tr>
<td>Magnify Pixel</td>
<td>Double click the left mouse button in the area within the Image Viewer in order to magnify the selected area in the Pixel Viewer screen.</td>
</tr>
</tbody>
</table>

³ W/L: Window Leveling
7-7 Mini Map and Pixel Value

Corresponds to @ in [Figure 7.27]

7-7-1 Mini Map

![Figure 7.39. Mini Map](image)

Allows the users to verify the area currently being viewed in the Image Viewer. The area within the green dotted border is the area currently displayed in the Image Viewer.

7-7-2 Pixel Value

![Figure 7.40. Pixel Value](image)

Displays the pixel value of the location the mouse cursor is hovering in the Image Viewer or the Pixel Viewer.
7-8 Histogram

Corresponds to ʰ in [Figure 7.24]

Displays the Histogram of the selected image

![Histogram Image]

Figure 7.41. Histogram

Supports Dynamic or Static mode subsequent to the Windows Leveling conditions

7-8-1 Dynamic

The minimum and maximum values will be fixed while the Histogram values may be adjusted if Window Leveling is attempted in the Image Viewer while in Dynamic mode.

7-8-2 Static

The Histogram values will be fixed while the minimum and maximum values may be adjusted if Window Leveling is attempted in the Image Viewer while in Static mode.
7-9 Status Bar
Corresponds to ① in [Figure 7.27]

7-9-1 Image Information Display

1. Current axis and Pixel value of the mouse cursor
   • Displayed as (X : [X Axis] Y : [Y Axis]) = [Pixel Value]
2. Mean: Mean Pixel Value of the image
3. STD: Standard Deviation of the Pixel value of the image
4. Min: Minimum value of the image Histogram
5. Max: Maximum value of the image Histogram
6. Peak: The Peak value and its Position of the image Histogram
   • Displayed as [Peak Value] at [Position]

7-9-2 Detector Status Display

* Supports only Ethernet Type and F600.

A green light will be displayed if the Detector is able to take a projection and a red light will be displayed if the Detector is unable to take a projection.
7-9-3 Wireless Information Display

* Support only Wireless Detector.

Information displayed when using a Wireless data communication.

7-9-4. Map File Loading Display

Green light will be displayed if a Map file required for Calibration has been loaded and the red light will be displayed if it has not been loaded.

✓ Gain: Gain Map Loading
✓ Pixel: Pixel Map Loading
✓ Panel: Panel Map Loading

If a Filtered Gain Map has been loaded in place of a Gain Map, the following FGain will be displayed.
7-10 Gain Calibration

Gain Calibration Procedure will update or modify the x-ray characteristics to be combined at the field to enhance the acquired image quality.

7-10-1 Gain Calibration Preparation

1) Detector and Grid Configuration
   The Detector and Grid configuration must be completed prior to performing Gain Calibration. Please refer to for details pertaining to the configuration.

2) MAP Data Location Configuration
   The provided Pixel Map (*.MAP) and Gain Map (*.GMP) should be Loaded prior to performing Gain Calibration. The destination location of the Map file provided by the X-ray image acquisition software (EConsole1 and etc.) should be registered in configuration.

Please refer to
7-4 Map File Registration for more details
7-10-2 Gain Calibration

Actual X-ray must be shot to project an image in order to perform Gain Calibration.

The Gain Calibration projection conditions are as follows. [Table 7-8]

**Table 7.8. Gain Calibration Condition**

<table>
<thead>
<tr>
<th>Conditions</th>
<th>Descriptions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Grid application</td>
<td>Projection must be taken without the application of Grid. (Cautions) The Grid Type must be set ‘None’ in Configuration - Detector - Grid selection - Type before Gain Calibration, and must be restored after Gain Calibration.</td>
</tr>
<tr>
<td>Subject</td>
<td>Projection must be done without a subject</td>
</tr>
<tr>
<td>X-ray exposure</td>
<td>X-ray exposure is required</td>
</tr>
<tr>
<td>X-ray radiation dose</td>
<td>Adjust the mean pixel value of the projected image to be between 3,000 ~ 4,000 X-ray Condition example) 70kVp, 200mA, 2mAs</td>
</tr>
<tr>
<td>SID</td>
<td>Stand: 150 cm, Table: 100 cm</td>
</tr>
<tr>
<td>Number of projections</td>
<td>Default Value: 7 counts Configuration possible in Configuration - General - Calibration - Count.</td>
</tr>
<tr>
<td>Projection interval</td>
<td>Default Value: 60 Seconds Configuration possible in Configuration - General - Calibration - Interval.</td>
</tr>
<tr>
<td>Other things</td>
<td>Collimator should be open maximally X-ray should be set to be exposed in the whole Detector Detector should be aligned in the center</td>
</tr>
</tbody>
</table>
1) **Detector Selection**
Select the Detector to perform the Gain Calibration from the Detector Menu.

![Detector Menu](image1)

**Figure 7.43. Detector Selection**

2) **Starting Gain Map Calibration**
Next, select Gain map calibration from Tools Menu or select the shortcut icon.

![Tool Menu](image2)

**Figure 7.44. Starting Gain Calibration**

A notification message will appear. Select ‘OK’.

![Notification](image3)

**Figure 7.45. Gain Calibration Start Notification**
Next, ECali1 alerts whether the radiation dose is appropriate or whether it should be automatically calculated. Proceed by selecting ‘OK’.

![Notification]

Would you like to examine the exposure dose for the calibration?

**Figure 2. X-ray Radiation Dose Check Activation**

Next, a main screen will appear. Proceed with the X-ray projection at this point in order to acquire an image.

![Projection Standby Main Screen]

**Figure 7.473. Projection Standby Main Screen**

The program automatically determines the appropriateness of the X-ray radiation dose when the image is acquired.

![X-ray Radiation Dose Verification Notification]

**Figure 7.48. X-ray Radiation Dose Verification Notification**
If provided with a notification of low radiation dose, please select ‘OK’ then increase the X-ray radiation dose and re-project.
A notification will also appear if the X-ray radiation dose is high. Please select ‘OK’ then reduce the X-ray radiation dose and re-project.

If the X-ray radiation dose is appropriate, please select ‘OK’ and proceed with the projections.

A notification informing the requirement of 7 images will appear. The required number of images may be set in Configuration.
Select ‘OK’ and proceed with the projections of 7 images.

Figure 7.52. Starting the Gain Calibration Projection

Figure 7.53. Standby post Projection of 1 Image

Stand by until the next designated projection after the initial projection.

Figure 7.54. Projection Standby Timer

The next projection will take place after the projection standby timer disappears. The projection standby time may be set in configuration.
The Gain Calibration results are automatically saved as Gain Map (*.GMP) when all required images are projected and the existing files are backed-up.

![Figure 7.55. Notification for Gain Calibration Completion](image)

The existing GMP files are backed up in the [ECali1 Installation Folder]\MAP folder. The file name is as follows. [7-56]

![Figure 7.56. Example of a Back-up File](image)
7-11 Pixel Correction

If there are pixel defects or line defects needed to be calibrated, users can correct them manually.

7-11-1 Pixel Correction Preparation

1) Detector and Grid Configuration
   The Detector and Grid configuration must be completed prior to performing Pixel correction

2) Map Data Location Configuration
   The provided Pixel Map (*.MAP) should be loaded prior to performing Pixel Correction.
   The destination location of the Map file provided by the X-ray image acquisition
   Software (EConsole1 and etc.) should be registered in Configuration.
7-11-2 Pixel Correction Performance

At least 1 count of RAW image acquired through X-ray Exposure is required to perform Pixel Correction.

Table 7.4. Pixel Correction Conditions

<table>
<thead>
<tr>
<th>Condition</th>
<th>Descriptions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Grid application</td>
<td>Projection must be taken without the application of Grid</td>
</tr>
<tr>
<td>Subject</td>
<td>Projection must be done without a subject</td>
</tr>
<tr>
<td>X-ray exposure</td>
<td>X-ray exposure is required</td>
</tr>
<tr>
<td>Number of projection</td>
<td>More than 1 count. (One for check and correct defects, and others to verify correction)</td>
</tr>
<tr>
<td>Other things</td>
<td>Collimator should be open</td>
</tr>
</tbody>
</table>
1) **Detector Selection**  
Select the Detector to perform the Pixel Correction from the Detector Menu.

![Detector Menu](image)

**Figure 7.56. Panel Selection**

2) **Pixel Correction**  
Acquire the image by performing an X-ray projection from the main screen.

![Projection Standby Screen](image)

**Figure 7.57. Projection Standby Screen**

![Image Acquisition Screen post Projection](image)

**Figure 7.58. Image Acquisition Screen post Projection**
A defect of a point or line may exist for each Detector. [7-59] illustrates a Horizontal Line Defect.

There are 3 types for Pixel Correction.

![Pixel Defects](image)

- **Point**
- **Horizontal Line**
- **Vertical Line**

Figure 7.60. Pixel Defects
The following are utilized to perform Pixel Correction. [Figure7-61]

![Pixel Correction Icon](image)

**Point**  **Horizontal Line**  **Vertical Line**

Figure 7.61. Pixel Correction Icon

Pixel Correction is performed in the following process.

① Display the Pixel Defect in the Pixel Viewer

② Select the appropriate shortcut icon

③ Ctrl+Left Click the area of Defect in the Pixel Viewer

![Pixel Correction (Horizontal Line Defect)](image)

Figure 7.62. Pixel Correction (Horizontal Line Defect)
The selected Defect will be displayed in green.
The selected Defect will be displayed in blue if the Defect is already saved.

![Figure 7.63. Example Post Performance of Pixel Correction](image)

Perform Pixel Corrections for all existing Defect and save to complete the process.

![Figure 7.64. Save Pixel Map](image)
7-12 Configuration

The Configuration will appear through Option Menu - Configuration.

- a: Configuration detailed tab
- b: Save the modified contents and close the window.
  - Automatically restart the program when necessary.
- c: Close the window without saving the contents.
7-12-1 General

Configure the number and type of Detector being utilized.

In addition, Configuration matters required in the process of calibration may be modified.

Figure 7.66. General
1) Detector Configuration

![Detector Configuration Diagram]

Figure 7.67. Detector Configuration

<table>
<thead>
<tr>
<th>Category</th>
<th>Descriptions</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Type of Panel Model which will be added or modified</td>
</tr>
<tr>
<td>2</td>
<td>Type of Panel added (registered)</td>
</tr>
<tr>
<td>3</td>
<td>Adds the Panel Model selected in 1</td>
</tr>
</tbody>
</table>
| 4        | Modifies the Model of the Panel selected in 2  
                      Here, the Model is replaced by the Model selected in 1 |
| 5        | Deletes the most recently registered Panel.  
                      (With disregards to selection, the item at the bottom of the list will be deleted.) |
2) Calibration Configuration

![Calibration Configuration](image)

**Figure 7.68. Calibration Configuration**

<table>
<thead>
<tr>
<th>Category</th>
<th>Descriptions</th>
</tr>
</thead>
<tbody>
<tr>
<td>①</td>
<td>Configures the number of images to be project when performing Gain/Grid Calibration. The Default value is 7 counts.</td>
</tr>
<tr>
<td>②</td>
<td>Checks the X-ray radiation dose when performing Gain Calibration and provides an option for re-projection if the radiation dose is unfit. It is recommended for accurate Calibration.</td>
</tr>
<tr>
<td>③</td>
<td>Configures the interval between each image projections when performing Gain/Grid/Panel Calibration. The default value is 60 sec.</td>
</tr>
<tr>
<td>④</td>
<td>Select whether to set the Grain Map as Filtered Gain Map or Gain Map.</td>
</tr>
</tbody>
</table>
7-12-2 Options

Figure 7.69. Options Configuration

Table 7-6. Options Descriptions

<table>
<thead>
<tr>
<th>Category</th>
<th>Descriptions</th>
</tr>
</thead>
<tbody>
<tr>
<td>①</td>
<td>Configures the use of Auto Update function.</td>
</tr>
<tr>
<td>②</td>
<td>Configures the use of the virtual keyboard for Touch environments.</td>
</tr>
<tr>
<td>③</td>
<td>Selects the editing method utilized during the Pixel Map Calibration process.</td>
</tr>
<tr>
<td>④</td>
<td>Selects the port connected with USB Switch Box.</td>
</tr>
<tr>
<td>⑤</td>
<td>Checks ‘Fix Min / Max’ and inputs Min and Max pixel value to use fixed window level.</td>
</tr>
</tbody>
</table>
7-13 Detector

Allows the modification of necessary configuration for each Detector. Number of tabs corresponding to the number of registered Panels through Configuration – General will be generated.

![Figure 4. Configuration – Changes in the Number of Panel Tabs](image)

The following may be configured through Panel Configurations:

- Map files save path
  - Save path of the Map file required for Calibration
- Edge cut setting
  - The boarders of the image
- Grid selection
  - Configurations relevant to the type of Grid and Filter Type being used
- F600 Model Configuration
  - Configurations only for F600
7-13-1 Map File Path

![Map File Path]

**Figure 7.71. Map File Path**

<table>
<thead>
<tr>
<th>Category</th>
<th>Descriptions</th>
</tr>
</thead>
<tbody>
<tr>
<td>①</td>
<td>Configures the save path of the Pixel Map file. The File Dialogue may be opened by selecting ‘...’ on the right.</td>
</tr>
<tr>
<td>②</td>
<td>Configures the save path of the Gain Map file. The File Dialogue may be opened by selecting ‘...’ on the right.</td>
</tr>
<tr>
<td>③</td>
<td>Configures the save path of the Panel Map file. The File Dialogue may be opened by selecting ‘...’ on the right.</td>
</tr>
<tr>
<td>④</td>
<td>Previous Map files are backed-up when Map files are saved multiple times. Utilized when restoring the Map file with the previous file. However, restore cannot be processed if a backed-up Map file does not exist.</td>
</tr>
</tbody>
</table>

Table 7.7. Map File Path Descriptions
7-13-2 Edge Cut Setting

Fixed placement of a boarder on the image.
The Pixel value and width may be designated in this configuration.

Table 7.8. Edge Cut Setting Descriptions

<table>
<thead>
<tr>
<th>Category</th>
<th>Descriptions</th>
</tr>
</thead>
<tbody>
<tr>
<td>①</td>
<td>Configures the Threshold Value of the image. The default is determined by each model. If the Pixel Value of the image imported from the Detector exceeds 11000, the values will be automatically adjusted to 11000 if this value is set to 11000.</td>
</tr>
<tr>
<td>②</td>
<td>Configures the Pixel Value of the additional boarder which will be placed on the image. The default value is 11000.</td>
</tr>
<tr>
<td>③</td>
<td>Configures the width of the top, bottom, left and right boarder. Unit is in Pixel. The Default value is all 10.</td>
</tr>
</tbody>
</table>
When you encounter problems or error messages in the ECali1 while using this equipment, search the table below for the problem or error message and try the solutions.

If the problem persists, turn off the detector and consult your sales representative or local DRTECH dealer. Please refer to the details of the problem or error messages.

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Cause/Error messages in the EVS Control Software</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>Failed to turn on.</td>
<td>Power cable is not attached</td>
<td>Attach a power cable with SSU</td>
</tr>
<tr>
<td>LINK lamp does not light up</td>
<td>The communication circuit is not secured</td>
<td>Register the detector and make connection to the ECali1.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>In wireless configuration, confirm the following conditions:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• There is no obstacle between the wireless module of the detector and the wireless access points.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• The wireless access point is turned on.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>In wired configuration, confirm the following conditions:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• The detector cable is firmly connected to the SSU(power box).</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• The SSU(power supply) and the AP are firmly connected via cable.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• The AP is turned on and network communication is functioning properly.</td>
</tr>
<tr>
<td>While the POWER lamp lights, READY and LINK lamps flash.</td>
<td>Data transmission error has occurred.</td>
<td>In wireless configuration, confirm the following conditions:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• The access point is turned on.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Wireless communication status is stable</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• The access point are firmly connected via cable.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>In wired configuration, confirm the following conditions:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• The detector cable is firmly connected to the detector.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• The SSU is turned on.</td>
</tr>
<tr>
<td></td>
<td>Exposure preparation error has occurred. / Error Code: 21</td>
<td>Confirm that the cables with the X-ray interface unit are connected securely and the X-ray interface box is turned on.</td>
</tr>
<tr>
<td>All the LED lamps flash.</td>
<td>Hardware error has occurred /Error Code: other than 21</td>
<td>Turn off the detector and turn it on again.</td>
</tr>
<tr>
<td>Two LED lamps flash and Turn off the detector and turn it on again. the other flashes slowly.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Maintenance and inspection

In order to ensure that the equipment is used safely and normally, be sure to inspect the equipment before use. If any problem is found during the inspection and cannot be corrected, please contact your sales representative or local DRTECH dealer.

Daily inspection

**WARNING**
For safety reasons, be sure to turn OFF the power to each piece of equipment before the following. Otherwise, an electric shock may result.

### Cable
1) Ensure that cables are not damaged and cable jackets are not torn.
2) Ensure that the power cord plugs are securely connected to both the equipment AC inlet and the AC outlet.

### Detector
1) Ensure that there are no loose screws or breaks.
2) Ensure that there is no dust or foreign matter on the external connector.
3) Ensure that there are no breaks or short-circuits in the power supply connector.

### After turning on the power
Be sure to start the ECali1 before performing the following inspection.
1) Perform test exposure.

### Monthly inspection
1) Conduct a Performance Test.
2) Regularly conduct a Self-diagnosis. For details, refer to the Setup Guide for the EVS Control Software.

### Yearly inspection
1) Perform a Performance Test or Self-diagnosis using a phantom or resolution chart, etc.

### Irregular inspection

#### Calibration
1) Perform Calibration when exposure conditions have changed significantly.
   For details, refer to the Setup Guide for the ECali1.
10-1. Main specifications

EVS 3643 X-ray detector
[Dimensional diagram] (unit mm)
SSU (System Synchronization Unit)

[Dimensional diagram] (unit mm)

Rated power supply
Input: 100-240 VAC, 50/60Hz
Output: DC +12 V 8.3A, 75W
10-2. Characteristics

(1) Typical patient doses
Typical patient doses are equivalent to 500-1000 speed film/screen systems.

(2) Sensitometric characteristics and Dynamic range
EVS 3643 Wireless responds linearly against the exposure range for 500-1000 speed film/screen where it can depict the clinical information. It means that EVS 3643 fully covers a dynamic range of 0.2-20 μGy at least.

(3) Spatial resolution properties
A typical MTF value at 2 cycle/mm, RQA5 is 0.35.
The level of uncertainty is estimated as less than ±10%.

(4) DQE
A typical DQE value at 2 μGy in 0 lp/mm is 0.6.
The level of uncertainty is estimated as less than ±10%.
The product safety standards that apply to the EVS 3643, which includes the following equipment, are as followings.

- Detector
- SSU
- Wiring unit (sold separately, optional unit)

### 11-1. Medical equipment safety standards

#### Medical equipment classification

<table>
<thead>
<tr>
<th>Type of protection against electrical shock</th>
<th>Class</th>
<th>ME Equipment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Degree of protection against electrical shock</td>
<td>Type</td>
<td>B Applied Parts</td>
</tr>
<tr>
<td>(Applied Part: Detector panel)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Degree of protection against ingress of water</td>
<td>IPX0</td>
<td></td>
</tr>
<tr>
<td>Mode of operation</td>
<td></td>
<td>Continuous Operation</td>
</tr>
<tr>
<td>Flammable anesthetics</td>
<td></td>
<td>Not suitable for use in the presence of a flammable anesthetic mixture with air or with oxygen or nitrous oxide</td>
</tr>
</tbody>
</table>

#### Product safety standards

**USA and Canada**

- UL 60601-1 Ed.1.0:2003
- CAN/CSA C22.2 No.601.1
- IEC 60601-1-1 Ed.2.0:2000
- IEC 60601-1-2 Ed.2.1:2004
- IEC 60601-1-3 Ed.1.0:1994
- IEC 60601-1-4 Ed.1.1:2000
- IEC 60601-2-32 Ed.1.0:1994

- Medical electrical equipment-Part 1: General requirements for safety
- Medical electrical equipment-Part 1-1: Collateral standard: Safety requirements for medical electrical systems
- Medical electrical equipment-Part 1-2: Collateral standard: Electromagnetic compatibility-Requirements and tests
- Medical electrical equipment-Part1: Collateral standard: General requirements for radiation protection in diagnostic X-ray equipment
- Medical electrical equipment-Part 1-4: Collateral Standard: Programmable electrical medical systems
- Medical electrical equipment-Part 2: Particular requirements for the safety of associated equipment of X-ray equipment
- Biological evaluation of medical devices
- Part 1: Evaluation and testing within a risk management process
- Part 5: Tests for in vitro cytotoxicity
- Part 10: Tests for irritation and delayed-type hypersensitivity
11. Regulatory information

**European Union**

MDD(93/42/EEC)  
EN 60601-1:1990+  
EN 60601-1-1:2001  
EN 60601-1-2:2001  
EN 60601-1-3(29.203):1994  
EN 60601-1-6:2004  
EN 60601-2-32:1994  
EN 62304:2006  
EN 62366:2008  
EN ISO 14971:2007  

**Medical equipment safety standards**

**Declaration of conformity**

**U.S.A.**  
FCC Part 15 Subpart B Class A and Part 15 Subpart C & E (RF Exposure)  
RSS-210  
ETSI EN300 328-1,-2 / 300 893-1,-2(Emission)  
ETSI EN301 489-1,-17 (Immunity)  
AS4268  
IDA TS-14

**For U.S.A. and Canada**

- **FCC/IC compliance**

This device complies with Part 15 of the FCC Rules and RSS-Gen of IC Rules.  
Operation is subject to the following two conditions:  
1. This device may not cause harmful interference.
2. This device must accept any interference received, including interference that may cause undesired operation.

Note: This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference when the equipment is operated in a commercial environment. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instruction manual, may cause harmful interference to radio communications. Operation of this equipment in a residential area is likely to cause harmful interference in which case the user will be required to correct the interference at his own expense.

**FCC WARNING:**

Changes or modifications not expressly approved by the party responsible for compliance could void the user’s authority to operate the equipment.

This transmitter must not be co-located or operated in conjunction with any other antenna or transmitter

5150~5250 MHz band is restricted to indoor operations only. (for FCC and CE)

FCC ID: RNH-EVS3643

FCC ID: RNH-EVS3643 in the RF module do not use DFS band.  *RF modue FCC ID: RYK-WUBR508N.

Host device of the approved module shall be marked with the following item:
Contains Transmitter Module FCC ID: RYK-WUBR508N

**Disposal**

Disposal of this product in an unlawful manner may have negative effects on health and on the environment. When disposing of this product, therefore, be absolutely sure to follow the procedure which is in conformity with the laws and regulations applicable in your area.

The expected life span of EVS 3643 system is about 3 years.
### 11. Regulatory information

**For European Union (and EEA)**

<table>
<thead>
<tr>
<th>Language</th>
<th>Translation</th>
</tr>
</thead>
<tbody>
<tr>
<td>English</td>
<td>Hereby, DRTECH Inc., declares that this EVS-3643 Wireless is in compliance with the essential requirements and other relevant provisions of Directive 1999/5/EC.</td>
</tr>
<tr>
<td>Česky</td>
<td>DRTECH Inc. tímto prohlašuje, že tento EVS 3643 Wireless je ve shodě se základními požadavky a dalšími příslušnými ustanoveními směrnice 1999/5/ES.</td>
</tr>
<tr>
<td>Dansk</td>
<td>Undertegnede DRTECH Inc. erklærer herved, at følgende udstyr EVS 3643 Wireless overholder de væsentlige krav og øvrige relevante krav i direktiv 1999/5/EF.</td>
</tr>
<tr>
<td>Eesti</td>
<td>Käesolevaga kinnitab DRTECH Inc. seadm e EVS 3643 Wireless vastavust direktiivi 1999/5/EÜ põhinõuetele ja nimetatud direktiivist tulenevatele teistele asjakohastele sätetele.</td>
</tr>
<tr>
<td>Español</td>
<td>Por medio de la presente DRTECH Inc. declara que el EVS 3643 Wireless cumple con los requisitos esenciales y cualesquiera otras disposiciones aplicables o exigibles de la Directiva 1999/5/CE.</td>
</tr>
<tr>
<td>Ελληνική</td>
<td>ΜΕΤΗΝ ΠΑΡΥΣΑ DRTECH Inc. ΔΗΛΩΝΕΙ ΤΙ EVS 3643 Wireless ΣΤΗΝ ΜΡΦΩΝΕΤΑΙ ΠΡΣ ΤΗΣ ΥΠΩΔΕΙΩΝ ΑΠΑΙΤΗΣΕΩΝ ΚΑΙ ΤΗΣ ΛΙΠΕΣ ΥΣΤΙΚΕΣ ΔΙΑΤΑΞΕΙΣ ΤΗΣ ΔΗΓΙΑΣ 1999/5/ΕΚ.</td>
</tr>
<tr>
<td>Français</td>
<td>Par la présente DRTECH Inc. déclare que l’appareil EVS 3643 Wireless est conforme aux exigences essentielles et aux autres dispositions pertinentes de la directive 1999/5/CE.</td>
</tr>
<tr>
<td>Italiano</td>
<td>Con la presente DRTECH Inc. dichiara che questo EVS 3643 Wireless è conforme ai requisiti essenziali ed alle altre disposizioni pertinenti stabilite dalla direttiva 1999/5/CE.</td>
</tr>
<tr>
<td>Latviski</td>
<td>Ar šo DRTECH Inc. deklare, ka EVS 3643 Wireless atbilst Direktivas 1999/5/EK butiskajam prasībām un ar to saistītajiem noteikumiem.</td>
</tr>
<tr>
<td>Nederlan ds</td>
<td>Hierbij verklaart DRTECH Inc. dat het toestel EVS 3643 Wireless in overeenstemming is met de essentiële eisen en de andere relevante bepalingen van richtlijn 1999/5/EG.</td>
</tr>
<tr>
<td>Malti</td>
<td>Hawnhekk, DRTECH Inc., jiddikjara li dan EVS 3643 Wireless jikkonforma malhtigijiet essenzjali u ma provvedimenti ohrajn relevanti li hemm fid-Dirrettiva 1999/5/EC.</td>
</tr>
<tr>
<td>Magyar</td>
<td>Alulírott, DRTECH Inc. nyilatkozom, hogy a EVS 3643 Wireless megfelel a základní požadavky és az 1999/5/EG irányelv egyéb előírásainak.</td>
</tr>
<tr>
<td>Polski</td>
<td>Niniejszym DRTECH Inc. oświadczają, że EVS 3643 Wireless jest zgodny z zasadniczymi wymogami oraz pozostałymi stosownymi postanowieniami Dyrektywy 1999/5/EC.</td>
</tr>
<tr>
<td>Português</td>
<td>DRTECH Inc. declara que este EVS 3643 Wireless está conforme com os requisitos essenciais e outras disposições da Directiva 1999/5/CE.</td>
</tr>
<tr>
<td>Slovensko</td>
<td>DRTECH Inc. izjavlja, da je ta EVS 3643 Wireless v skladu z bistvenimi zahtevami in ostalimi relevantnimi dolocili direktive 1999/5/ES.</td>
</tr>
<tr>
<td>Slovensk y</td>
<td>DRTECH Inc. týmto vyhlasuje, že [typ zariadenia] splňa základné požiadavky a všetky príslušné ustanovenia Smernice 1999/5/ES.</td>
</tr>
<tr>
<td>Suomi</td>
<td>DRTECH Inc. vakuuttaa täten että EVS 3643 Wireless tyypipienen laite on direktiivin 1999/5/EY oleellisten vaatimusten ja sitä koskevien direktiivin muiden ehtojen mukainen.</td>
</tr>
<tr>
<td>Svenska</td>
<td>Härmed intygar DRTECH Inc. att denna EVS 3643 Wireless står i överensstämmelse med de väsentliga egenskapskrav och övriga relevant bestämmelser som framgår av direktiv 1999/5/EG.</td>
</tr>
<tr>
<td>Íslenska</td>
<td>Hér með lýsir DRTECH Inc. yfir því að EVS 3643 Wireless er í samræmi við grunnkröfur og aðrar kröfur, sem gerðar eru í tilskipun 1999/5/EC.</td>
</tr>
<tr>
<td>Norsk</td>
<td>DRTECH Inc. erklærer herved at utstyret EVS-3643 Wireless er i samsvar med de grunnleggende krav og øvrige relevante krav i direktiv 1999/5/EF.</td>
</tr>
</tbody>
</table>
## 11. Regulatory information

<table>
<thead>
<tr>
<th>AT</th>
<th>BE</th>
<th>BG</th>
<th>CY</th>
<th>CZ</th>
<th>DK</th>
<th>EE</th>
<th>FI</th>
</tr>
</thead>
<tbody>
<tr>
<td>FR*</td>
<td>DE</td>
<td>GR</td>
<td>HU</td>
<td>IE</td>
<td>IT</td>
<td>LV</td>
<td>LT</td>
</tr>
<tr>
<td>LU</td>
<td>MT</td>
<td>NL</td>
<td>PL</td>
<td>PT</td>
<td>RO</td>
<td>SK</td>
<td>SI</td>
</tr>
<tr>
<td>ES</td>
<td>SE</td>
<td>GB</td>
<td>IS</td>
<td>LI</td>
<td>NO</td>
<td>CH</td>
<td></td>
</tr>
</tbody>
</table>

* In France, outdoor use of this equipment is prohibited.

**For Singapore**

Complies with IDA Standards N1624-10
11-3. Medical equipment safety standards

The EVS 3643 detector and other components have labels and markings on them. Their contents and locations are indicated below.

Caution:
Do not jolt or apply excessive load.

Non-ionized radiation

The Waste Electrical and Electronic Equipment Regulations indicates separate collection for electrical and electronic equipment.

Certification mark that indicates the product complies with UL 60601-1 and CAN/CSA C22.2 No.601.1, that specifies protection against fire, electric shock, and mechanical hazards.

For U.S.A
Caution:
Federal law restricts this device to sale by or on the order of a licensed practitioner.

For European Union (EEC Countries)
Hereby, DRTECH Inc., declares that this EVS-3643 Wireless is in compliance with the essential requirements and other relevant provisions of Directive 1999/5/EC and 93/42/EEC. “0120” shows the notified body number for MDD.

MANUFACTURED:
(S/N)
Year and Month of production
Serial number in six digits
This mark shows compliance of the equipment with Directive 93/42/EEC

Protective Earth (Ground)

Direct Current

Alternating Current

Equipotentially.

Attention, Consult accompanying documents.

Power Off.

Power On

Read and understand all instructions and warning labels in the product documentation before using the equipment.
Keep manual for future reference
Other components of the EVS 3643 system

SSU

Caution:
Do not jolt or apply excessive load.

The Waste Electrical and Electronic Equipment Regulations indicates separate collection for electrical and electronic equipment.

Certification mark that indicates the product complies with UL 60601-1 and CAN/CSA C22.2 No.601.1, that specifies protection against fire, electric shock, and mechanical hazards.

For European Union (EEC Countries)
Hereby, DRTECH Inc., declares that this EVS 3643 Wireless is in compliance with the essential requirements and other relevant provisions of Directive 1999/5/EC and 93/42/EEC. "0120" shows the notified body number for MDD.

MANUFACTURED:
Year and Month of production
Serial number in six digits
Protective Earth (Ground)

Direct Current

Alternating Current

Equipotentially.

Attention, Consult accompanying documents.

Power Off.

Power On

Read and understand all instructions and warning labels in the product documentation before using the equipment.
Keep manual for future reference
11-4. Guidance and manufacturer’s declaration for EMC

Electromagnetic emissions

The EVS 3643 Wireless is intended for use in the electromagnetic environment specified below. The user of the EVS 3643 Wireless should assure that it is used in such an environment.

<table>
<thead>
<tr>
<th>Emission Test</th>
<th>Compliance</th>
<th>Electromagnetic Environment - Guidance</th>
</tr>
</thead>
<tbody>
<tr>
<td>RF emissions CISPR11</td>
<td>GROUP 1</td>
<td>The EVS 3643 Wireless uses RF energy only for its internal function. Therefore, its RF emissions are very low and are not likely to cause any interference in nearby electromagnetic equipment.</td>
</tr>
<tr>
<td>RF emissions CISPR11</td>
<td>Class A</td>
<td></td>
</tr>
<tr>
<td>Harmonic emissions IEC 61000-3-2</td>
<td>Class A</td>
<td>The EVS-3643 Wireless is suitable for use in all establishments other than domestic and those directly connected to the public low-voltage power supply network that supplies buildings used for domestic purposes.</td>
</tr>
<tr>
<td>Voltage fluctuations/ flicker emissions IEC 61000-3-3</td>
<td>*1</td>
<td></td>
</tr>
</tbody>
</table>

1: Applies to regions where the rated voltage is 220 V or higher. Not applicable to regions where the rated voltage is less than 220 V.

Electromagnetic immunity

The EVS 3643 Wireless is intended for use in the electromagnetic environment specified below. The user of the EVS 3643 Wireless should assure that it is used in such an environment.

<table>
<thead>
<tr>
<th>Immunity Test</th>
<th>IEC 60601 Test Level</th>
<th>Compliance Level</th>
<th>Electromagnetic Environment – Guidance</th>
</tr>
</thead>
<tbody>
<tr>
<td>Electrostatic discharge (ESD) IEC 61000-4-2</td>
<td>±(2, 4, 6) kV contact ±(2, 4, 8) kV air</td>
<td>±(2, 4, 6) kV contact ±(2, 4, 8) kV air</td>
<td>Floors should be wood, concrete or ceramic tile. If floors are covered with synthetic material, the relative humidity should be at least 30%.</td>
</tr>
<tr>
<td>Electrical fast transient/ burst IEC 61000-4-4</td>
<td>±2 kV for power supply lines ±1 kV for input/output lines</td>
<td>±2 kV for power supply lines ±1 kV for input/output lines</td>
<td>Mains power quality should be that of a typical commercial or hospital environment.</td>
</tr>
<tr>
<td>Surge IEC 61000-4-5</td>
<td>±1 kV differential mode ±2 kV common mode</td>
<td>±1 kV differential mode ±2 kV common mode</td>
<td>Mains power quality should be that of a typical commercial or hospital environment</td>
</tr>
</tbody>
</table>

NOTE: UT is the a.c. mains voltage prior to application of the test level.
### 11. Regulatory information

<table>
<thead>
<tr>
<th>Immunity Test</th>
<th>IEC 60601 Test Level</th>
<th>Compliance Level</th>
<th>Electromagnetic Environment – Guidance</th>
</tr>
</thead>
<tbody>
<tr>
<td>Voltage dips, short interruptions and voltage variations on power supply input lines</td>
<td>IEC 61000-4-11</td>
<td>&lt;5% UT (&lt;95% dip in UT) for 0.5 cycle. 40% UT (60% dip in UT) for 5 cycles 70% UT (30% dip in UT) for 25 cycles &lt;5% UT (&lt;95% dip in UT) for 5 sec.</td>
<td>&lt;5% UT (&lt;95% dip in UT) for 0.5 cycle. 40% UT (60% dip in UT) for 5 cycles 70% UT (30% dip in UT) for 25 cycles &lt;5% UT (&lt;95% dip in UT) for 5 sec.</td>
</tr>
<tr>
<td>Power frequency (50/60Hz) magnetic field</td>
<td>IEC 61000-4-8</td>
<td>3 A/m</td>
<td>3 A/m</td>
</tr>
<tr>
<td>Conducted RF</td>
<td>IEC 61000-4-6</td>
<td>3 Vrms 150 kHz to 800 MHz</td>
<td>3 Vrms</td>
</tr>
<tr>
<td>Radiated RF</td>
<td>IEC 61000-4-3</td>
<td>3 V/m 80 MHz to 2.5 GHz</td>
<td>3 V/m</td>
</tr>
</tbody>
</table>

**NOTE 1:** At 80 MHz and 800 MHz, the higher frequency range applies.

**NOTE 2:** These guidelines may not apply in all situations. Electromagnetic propagation is affected by absorption and reflections from structures, object and people.
a Field strengths from fixed transmitters, such as base stations for radio (cellular/cordless) telephones and land mobile radios, amateur radio, AM and FM radio broadcast and TV broadcast cannot be predicted theoretically with accuracy. To assess the electromagnetic environment due to fixed RF transmitters, an electromagnetic site survey should be considered. If the measured field strength in the location in which the EVS 3643 Wireless is used exceeds the applicable RF compliance level above, the EVS 3643 Wireless should be observed to verify normal operation. If abnormal performance is observed, additional measures may be necessary, such as reorienting or relocating the EVS 3643 Wireless.

b Over the frequency range 150 kHz to 80 MHz, field strengths should be less than 3 V/m.
12. Warranty

DRTECH Inc. warrants that this product will be free from defects in materials and workmanship for a period of twelve (12) months from the date of delivery. If any such product proves defective during this warranty period, DRTECH Inc. at its option, either will repair the defective product without charge for parts and labor, or will provide a replacement in exchange for the defective product. In order to obtain service under this warranty, Customer must notify DRTECH Inc. of the defect before the expiration of the warranty period and make suitable arrangements for the performance of service. Customer shall be responsible for packaging and shipping the defective product to the service center designated by DRTECH Inc. with shipping charges prepaid. DRTECH Inc. shall pay for the return of the product to customer if the shipment is to a location within the country in which the DRTECH Inc. designated service center is located. Customer shall be responsible for paying all shipping charges, duties, taxes, and any other charges for products returned to any other locations.

This warranty shall not apply to any defect, failure, or damage caused by improper or inadequate maintenance and care. DRTECH Inc. shall not be obligated to furnish service under this warranty to repair damage resulting from attempts by personnel other than DRTECH Inc. or its representatives to install, repair, or service this product, to repair damage resulting from improper use or connection to incompatible equipment or power source; or to service a product that has been modified or integrated with other products when the effect of such modification or integration increases the time or difficulty of servicing the product.

THIS WARRANTY IS GIVEN BY DRTECH Inc. WITH RESPECT TO THIS PRODUCT IN LIEU OF ANY OTHER WARRANTIES, EXPRESS OR IMPLIED. DRTECH Inc. AND ITS VENDOR DISCLAIM ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. DRTECH Inc. RESPONSIBILITY TO REPAIR OR REPLACE DEFECTIVE PRODUCTS IS THE SOLE REMEDY PROVIDED TO THE CUSTOMER FOR BREACH OF THIS WARRANTY. DRTECH AND ITS VENDORS WILL NOT BE LIABLE FOR ANY INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES IRRESPECTIVE OF WHETHER VIEWORKS CO., LTD OR THE VENDOR HAS ADVANCE NOTICE OF THE POSSIBILITY OF SUCH DAMAGES.

There are no warranties which extend beyond the description mentioned in this document.
<table>
<thead>
<tr>
<th>Revision</th>
<th>Date</th>
<th>Descriptions</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.0</td>
<td>Feb. 11, 2014</td>
<td>Initial Release</td>
</tr>
</tbody>
</table>
5. Operating procedure

DRTECH

DRTECH Inc.

Suite No.2 3 Floor, 29
Dunchon-daero541beon -gil,
Jungwon-gu, Seongnam-si, Gyeonggi-do, Republic of Korea
Web Site : http://www.drtech.co.kr
Customer Support Team
E-mail : drtech@drtech.co.kr
Tel : +82 31 730 6805 / Fax : +82 31 730 6899

European representative: